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Cleaning your AFT for return to Sunburst Sensors

After making seawater measurements and before storing the AFT or returning it to Sunburst Sensors
for refurbishment, the AFT wet chamber should be flushed with deionized water after removal from
a seawater line to prevent mineral and/or reagent build-up in the plumbing. The lid to the wet
chamber should be removed (Figure ??, and the surfaces gently wiped with a clean cloth before
long term storage. The flow cell should also be flushed with deionized water using the procedure
described in section 7.
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Warnings and Safety

To prevent damage to the Autonomous Flow-Through instrument (AFT), please carefully read
the operating instructions before attempting to use your instrument. The cable provided is for
bench-top programming and download of the AFT data and is NOT submersible!

Handling

The AFT is reagent-based with the reagent stored in sealed foil bags underneath the instrument.
It is possible, though very unlikely, that these bags may leak or rupture. In case of exposure to the
reagent, please refer to the material safety data sheets in section 9 of this manual.

AFT Power

The AFT is powered externally using common wall outlet power. Observe common safety protocols
when using any external power, especially in a wet environment. While the instrument is diode
protected for reverse voltage, large voltages will damage the instrument. Connect with care!
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1 Introduction to the AFT-pH

1.1 What’s in the box...

The rugged instrument case for your AFT should contain the following upon arrival:

1. AFT-pH Instrument

2. AFT Operating Manual

3. Communication/Power Cable

4. AFT Software Disc

5. De-Clogging Kit for air-locked pump

6. Pre-Deployment Checklist

7. Inlet pressure gauge assembly

8. Any external instruments or reagent ordered, though these may ship separately.

9. Power cable adapter kit.

If any of these materials is damaged or missing, please contact Sunburst Sensors immediately.

Figure 1: Operation overview.
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1.2 Overview of Communication

Figure 1 gives an overview of how the AFT-pH operates and interacts with the AFT-Client software.
The AFT uses a time-stamped, records based system to store and transmit data. There are two
main types of records; Data and Status. Data records consist of raw measurement data, while status
records contain information about the state of the instrument (start, stop, battery low, error, etc.)

Once running, all records are stored to internal memory for later download. Additionally they are
transmitted over the serial port, though for energy efficiency the port only wakes up long enough
to send the data.

Data records transmitted to the client can be displayed in real time via the Real Time Data button
(enabled once data is detected). The user selects a column set to choose which quantities to view.
Data can be shown in columnar (spread-sheet) display or as a graph.

The SAMI Client software sends configuration data (start time, sampling interval, etc.) and com-
mands to the AFT (start, stop, erase, etc.) It also allows the download of data from the instrument.
Data is downloaded into a text file that contains the configuration data and raw signal intensities
as well as any status records. The user can then open and parse that file or data can be exported
to tab-delimited files for use in other graphing or analytical software from the data viewer (Section
4).

1.3 AFT-pH Hardware

The AFT is divided into three discrete sections, the dry chamber, wet chamber, and reagent housing.
These are described below.

Figure 2: AFT hardware description.

Dry chamber: This houses backup batteries, electronic controller board, optics, pump and valve.
This area must be kept closed during operation and dry at all times.
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Wet chamber: This is the area that the seawater flows through. Within this section are the seawater
inlet, flow cell, mixer, and thermistor. The flow cell outlet should be directed to the seawater outlet
to prevent reagent from contaminating the seawater being measured.

Reagent housing: This compartment underneath the AFT stores the bag of reagent.

Cable: See Section 4.3.
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2 AFT Deployment Considerations

The AFT-pH is recommended for use in waters with salinity and pH ranges of 25-40 and 7-9,
respectively, at temperatures ranging from 0 to 35◦C. The AFT can be configured to measure
waters with lower salinity and pH. The AFT is intended for measurements of flow-through seawater
from a ship sampling line, but can also be used to measure pH of discrete samples. Recommended
configurations for both are described here.

2.1 Installation for flow-through seawater measurement

Figure 3 shows two possible configurations for installing the AFT with other instruments present.
Both configurations are suggestions and may not be applicable to the user’s actual infrastructure.
These configurations are suggested because they should reduce the pressurization and temperature
effects from having any significant impact.

Figure 3: Schematic of recommended installation configuration with other instruments present.

2.1.1 Pressure

Although the AFT flow chamber has been pressure tested for leakage to 12 psi, ideally there will
be 0 psi in the flow chamber during use. Care must be taken to maintain pressure well below 12
psi at all times to avoid leakage into the electronics or the surrounding laboratory area. Negative
pressure can cause bubbles and positive pressure can lead to inaccurate measurements. A flow rate
of 2–4Lmin−1 is recommended.

The flow chamber has an o-ring seal. If the user opens the flow chamber, care must be taken to
ensure the o-ring is not damaged or dirtied. It should be cleaned and checked if the chamber is
opened.

2.1.2 Temperature Change

Because the AFT is using temperature readings as part of each pH measurement, it is important
that the sample not be warmed or cooled significantly from where the sample is being drawn. Be
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aware that pumps and long lines can change the temperature. Since heat exchange is a function of
temperature gradient, the user may want to insulate the inlet line if there is a large temperature
difference between the sample and the laboratory.

If the temperature difference between the source water and the AFT is greater than 2 ◦C, the pH
should be corrected to in situ temperature. In order to report pH at in situ temperature, in situ
temperature must be measured, and the pH can be corrected using the following equation:

pHis = pHm + 0.015(Tm − Tis) (1)

where pHis is in situ pH, pHm is pH measured by the AFT, Tis is in situ temperature in C, and
Tm is temperature measured by the AFT in C.

2.1.3 Seawater contamination from AFT

The AFT-pH uses visible light absorbance to measure pH. Any instrument upstream of the AFT-pH
that alters the visible spectrum of the sample will interfere with pH measurements.

The AFT-pH instrument will inject ∼ 50µL of reagent into the sample stream with each measure-
ment. This may interfere with measurements from other instruments. The user should consider
this when configuring the AFT into a instrument lineup.

2.2 Using the AFT to measure the pH of discrete samples

The AFT-pH can be configured by Sunburst Sensors to measure the pH of discrete samples. If you
intend to use your AFT to measure discrete samples, please contact sales or technical support (note
that an AFT configured this way will use different software and firmware). In this configuration,
the AFT will have an additional 3-way solenoid valve to switch between sampling through the
wet chamber and sampling through the tubing that comes out the side of the instrument. When
sampling from the tubing, the sample should be placed in a thermostatted water bath. The water
bath should be circulated through the wet chamber of the AFT, with care to not apply excessive
positive or negative pressure. The inlet tubing should be placed inside the sample (see Figure 4).
Failure to circulate thermostatted water through the wet chamber will result in poor accuracy and
precision in the pH measurement, as pH is highly temperature sensitive. Note that when measuring
the pH of discrete samples, on the Settings tab, SAMI/AFT panel, "Bottle" must be chosen by
entering a "1." in the box.

2.3 pH Range

The measurable pH range of the AFT-pH is dictated by the pKa of the indicator, meta-cresol purple
(mCP), and is 7–9 in the standard configuration. Below and above this range, absorbances become
unreliable, and accuracy degrades. Different pH indicators in combination with different optics can
be used to target a different pH, but the targeted range will not exceed 2 pH units. Targeting a
pH range other than 7–9 requires using an indicator that is not as well characterized as mCP, and
could result in less accurate pH measurement. Table 1 summarizes available indicators and their
pH ranges at salinity of 35.

2.4 Salinity Range

The pKa of the indicator is dependent on temperature and salinity, and thus both need to be
measured for accurate pH measurement. If salinity is known to ± 1PSU, using the average, constant
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Figure 4: Recommended configuration for measuring pH on discrete samples.

salinity to calculate the measured pH is adequate. If salinity varies at the deployment site, salinity
should be measured with an external instrument. The salinity logged by a AFT that is controlling a
TSG can be used with AFT Client software to calculate pH. If the TSG logs salinity independently,
QC_PH can be used to calculate pH with the measured salinity.

AFT-pH instruments will be accurate to ± 0.004 pH through the salinity range of 25–40. Limited
results from lower salinities have given accuracies better than ± 0.015 pH.

2.5 Measurement Frequency

By collecting a higher quantity of data points you will more quickly use reagent, battery life, and
memory, which will shorten the longevity of your collection time. We encourage you to weigh your
options to maximize the effectiveness of your deployment while considering the questions you are
trying to answer through your research. Use tables 2 and ?? to help you decide upon the appropriate
parameters for your deployment.

Additionally, the internal pump appears to be less efficient at cold temperatures. In order for your
SAMI to provide the best data, we recommend that the instrument be set to a higher number of
flush pumps. Please contact Sunburst for instructions. Note that this will decrease battery life.
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Indicator pH Range∗

thymol blue 7.5–9.5

meta-cresol purple 7.1–9.1

phenol red 6.5–8.5

bromo-cresol
purple 4.9–6.9

Table 1: pH Measurement Range
∗at salinity 35 and 15◦C

Measurement
interval (min)

Measurement
frequency (d−1)

AFT total reagent
life (d), 550mL

15 96 114

30 48 229

60 24 458

120 12 916

Table 2: Reagent Life

2.6 Deployment in High TDS or Highly Productive Areas

The AFT-pH pumps about 3mL of seawater through the system for every pH measurement. The
hardware can become clogged or malfunctional and optical throughput can degrade due to fine
particles or biological fouling. If you are running water with high TDS through the AFT-pH, we
suggest that you flush your instrument wet chamber and flow cell with DI or tap water regularly
(monthly or more often if necessary). See section 7 for details.
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3 AFT-pH Theory of Operation

meta-cresol purple (mCP) is a pH sensitive dye that has been purified to use in AFT instruments
to increase measurement accuracy (Liu et al 2011). A seawater sample stream is pumped through
the instrument and injected with mCP solution. Two wavelength-specific LEDs send alternating
pulses of light through the indicator-sample mixture as it is pumped through a flow cell. Changes in
absorbance at the two wavelengths, Beer’s law, and the known molar absorptivities of the indicator
can be used to calculate the concentration of protonated and un-protonated indicator. The indicator
pKais then used to calculate pH using a derivation of the Henderson-Hasselbach equation.

3.1 Equilibrium Reaction

Spectrophotometric pH determination is based on the equilibrium reaction of a pH-dependent in-
dicator. A diprotic sulfonephthalein indicator, mCP, is used as the reagent. A single 50µL pulse
of reagent is introduced into the seawater stream. The acidic (HI– ) and basic (I2−) forms of the
indicator are found in varying quantities based on the pH of the seawater being tested.

Indicator equilibrium is described by Equation 2:

HI−
Ka

′

−−⇀↽−− H+ + I2− (2)

where Ka
′ is the apparent dissociation constant. The acidic and basic forms of the indicator are

measured at peak absorbance wavelengths of 434 nm (HI– ) and 578 nm (I2−), respectively. The
diprotic H2I form is not present at seawater pH and therefore is not considered in our applications.

Combining the log form of the indicator equilibrium expression, Beer’s Law, and the Henderson-
Hasselbalch equations results in Equation 3.

pH = pKa
′ + log

(
R− e1
e2 −Re3

)
, (3)

where pKa
′ is the log of the apparent dissociation constant, R is the absorbance ratio A578/A434

and the ei are the temperature-dependent ratios of the molar absorptivities (ε) of HI– and I2− at
434 and 578 nm. Equations 3–10 define temperature-dependent values for pKa

′ and ei used for
purified mCPin AFT instruments. T is temperature in Kelvin, t is temperature in Celcius, and S
is salinity.

pKa
′ =− 241.462 + 7085.72T−1 + 43.8332ln(T )− 0.0806406T − 0.3238S0.5 + 0.0807S

− 0.01157S1.5 + 0.000694S2 + 0.6367
(4)

e1 = εa578/εa434 (5)

e2 = εb578/εa434 (6)

e3 = εb434/εa434 (7)

εa434 = 18834 + 28.7533(25− t) (8)
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εa578 = 97.75 (9)

εb434 = 2296− 7.6338(25− t) (10)

εb578 = 40427 + 73.7198(25− t) (11)

3.2 Optical Path

The AFT uses pulsed LEDs with narrow band filters at wavelengths corresponding to maximum
optical absorbance for the protonated and deprotonated forms of the reagent. A reference photo-
diode tracks changes in the light sources. LEDs are imbedded in the flow cell which is mounted on
the controller board. The flow-cell optical path length is 1 cm.

3.3 Fluid Path

The AFT uses a 50µL solenoid pump to drive reagent through the system. A solenoid valve allows
the same pump to introduce a single pulse of reagent into the stream for each pH measurement.
A section of PEEK tubing upstream of the flow cell ensures thorough mixing of the sample and
reagent prior to optical measurements. The sample’s blank signal intensity (I0) is established by
taking measurements while pumping pure sample through the flow cell. After measuring the blank
signal, reagent is introduced into the flow stream and signal intensity (I) is collected as the pump
pushes the mixture through the flow-cell. At each measurement, reference intensities (I0ref and
Iref ) are also measured. The absorbance at each wavelength is calculated as:

A = −log
(
I

I0
×
I0ref
Iref

)
(12)

3.4 pH Perturbation and Data Record

Each pH data record consists of 28 light intensity measurements at each wavelength. The first four
measurements are averaged and used as the blank intensity values (I0). pH and indicator concen-
tration are calculated for each of the subsequent measurements. The addition of the mCPindicator
will slightly alter the pH of the sample. The pH of the initial sample is determined by extrapolat-
ing to the pH at zero indicator concentration using a regression of pH vs. indicator concentration
(Seidel et al. 2008).

3.5 Validation

The AFT-pH is validated by measuring the pH of Tris buffer at ∼ 25 ◦C. pH accuracy is better than
or equal to ± 0.004 at the time the AFT is sent to the customer.

3.6 References

For more information see the following references:

Delvalls, T.A., Dickson, A.G., 1998. The pH of Buffers Based on 2-amino-2-hydroxymethyl-1,3-
propanediol. Deep-Sea Research I, 45, 1541–1554.
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Purple for Spectrophotometric Seawater pH Measurements. Environmental Science and Technology,
45, 4862–4868.

DeGrandpre, M.D., Spaulding, R.S., Newton, J.O., Jaqueth, E.J., Hamblock, S.E., Umansky, A.A.,
Harris, K.E, 2014. Considerations for the measurement of spectrophotometric pH for ocean acidi-
fication and other studies. Limnology and Oceanography: Methods. 12, 830–839.

Martz, T.R., Carr, J.J., French, C.R., DeGrandpre, M.D., 2003. A submersible autonomous sensor
for spectrophotometric pH measurements of natural waters. Anal. Chem, 75, 1844–1850

Seidel, M.P., DeGrandpre, M.D., Dickson, A.G., 2008. A sensor for in situ indictor-based measure-
ments of seawater pH. Mar Chem. 109, 18–28.
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4 Software Installation, Communication and Power Cables

The AFT-pH requires the use of its own client software for programming, download and data
interpretation.

4.1 SAMI_Client Installation

AFT software is available for both Windows (XP and later) and Mac (OS X). To install the software,
simply insert the AFT Software disc, navigate to the SAMI_Client Application folder and drag the
folder for your computer platform to an appropriate location on your hard drive. You may want to
create a shortcut to your application, but it is important that the application itself remain in the
folder with the various sub-folders and other files for it to operate correctly. When you open the
SAMI_Client, if connected to the internet, the software will automatically search for updates. You
can update your software at http://www.sunburstsensors.com/swupdate

4.2 USB Serial Driver

Also on the disc is the driver for the serial-USB converter that is part of your communication cable.
Most modern computers will already have appropriate drivers installed or automatically install
this driver from the internet. If your computer does not recognize the USB-serial converter when
the cable is plugged in, you can opt to install from this folder. You may also use the internet to
download the latest driver from http://ftdichip.com/Drivers/VCP.htm

4.3 AFT Cables and Bulkheads

The black communication cable included with your instrument will have a 6-pin connector on one
end and on the other end, two diverging cables: a USB-serial converter and an AC power plug. The
communication cable’s bulkhead attachment should be attached to the side of your AFT instrument.

Pin Connection

1 DTR
2 RXD
3 TXD
4 Signal GND
5 Power +
6 Power GND

Table 3: Cable pin assigments. Figure 5: Bulgin cable connector.

4.4 Communicating

Once your instrument and computer are properly interfaced, you may start communicating with
the instrument. Under Preferences (in the Edit menu for PCs, and in the SAMI Client menu for
Macs) select the appropriate serial port. Click the Serial Open button to establish communication
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with your AFT. The indicator next to the Serial Port text will specify if your AFT is interfaced
with your computer (Figure 6). A red dot indicates a closed serial port while a green dot indicates
an open serial port.

To save battery power, the instrument will time-out after 3 minutes.

Failure to connect usually indicates that the wrong port has been selected. Double check your port
settings if you cannot connect. See also the troubleshooting section.

Figure 6: Instrument interface.
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5 SAMI_Client Interface

SAMI_Client is the interface for your instrument. SAMI_Client version 2 is used for the iSAMI,
PiSAMI, and SAMI2 and AFT instruments built in 2019 or later. SAMI2 and AFT instruments
build in 2018 or earlier use SAMI_Client version 1. The SAMI Client menu is divided into six
menus and three tabs to help you organize the information that you will be communicating to your
instrument.

The Control Tab is where you will find buttons that manage basic operations such as establishing
communication, downloading and erasing data, as well as launching and stopping the instrument.

The Settings Tab is where the deployment parameters and settings will be configured. The start
time, interval between measurements, and any external device settings are set here.

The Utility Tab contains an interactive display that shows live data being collected. There are also
controls that will allow you to create a pumping cycle so you can easily flush the instrument.

5.1 File Menu

Open Data File: Imports data files for data processing.

Import Hex File: Imports data that was stored by custom user systems in hex format.

Import Settings from File: Loads previously saved launch settings that have been created
under the Settings Tab. This feature will save you time once you have decided upon your
customized launch settings.

Save Settings As...: Stores launch settings from your Settings Tab so they may be easily
loaded at a later time. The Import Settings from File option will load these settings which
you have chosen under the SAMI Box in the Settings tab.

Exit (PC only): Shuts down AFT Client Software. This does not disrupt AFT operation.
This function is located in the SAMI_Client menu on a Mac.

About... (PC only): Software credits and version number displayed in dialogue window. This
function is located in the SAMI_Client menu on a Mac.

5.2 Edit Menu

The Preferences tool under this heading (PC only) is important for communication with your
instrument. If using a Mac, Preferences is found under SAMI_Client menu. Preferences contains
a dropdown menu that is populated with the serial ports on your computer. To communicate
successfully with your AFT, the correct serial port must be selected. If the correct serial port is
not present in the list, you may need to wait for the rest of the ports to be identified. Check
the Auto-Open serial port box to automatically establish communication with your AFT once the
correct serial port has been selected. You will also set your AFT to default to either Local Time
or GMT on the Preferences page.

5.3 SAMI Menu

Read SAMI Settings: The SAMI Launch Setting programmed into your AFT can be viewed
by choosing this option. A separate window will appear with the Settings displayed in list
format. This option is only active if the AFT is NOT running AND the Port Powered box is
checked on either the Control or Utility tab.

16



Figure 7: Read calibration window.

Read/Edit SAMI Text: The text added to the AFT under the Edit Text button on the control
tab can be viewed by selecting this option. This option is only active if the AFT is NOT
running AND the Port Powered box is checked on either the Control or Utility page.

Update Firmware: This action will be performed when software updates become available
through Sunburst Sensors. As you receive or download newer versions of the SAMI_Client,
upgrades to the firmware may accompany these. If required, an advisory message suggesting
update of the firmware will appear when you first connect to the AFT.

Read Cal Info: Figure 7 lets you view E values, AFT temperature offset compared to NIST-
traceable standard, and reagent type (1 is un-purified; 2 is purified). These values should
match the values on the calibration certificate that was shipped with the AFT after the most
recent refurbishment. If values do not match, contact Sunburst Sensors before deployment.

5.4 Help Menu

Various documents are available via the Help menu, including this manual, release notes for the
software detailing what changes have been made, use of external instruments, etc.

View Sunburst Website: This heading will direct you to http://www.sunburstsensors.com
for convenient access to our business, research, and contact information.

Send us Email: Directs email to Info@sunburstsensors.com

About SAMI application (PC): Brings up an information and credits window.

Check for Updates: If you have an internet connection the AFT Client software will auto-
matically check the Sunburst Sensors website for updates to the software upon launch. You
can manually check via this menu item.

5.5 Control Tab

The Control tab is where you establish communication and power with the AFT, start and stop
sample collection, and download data.
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Figure 8: Control tab.

5.5.1 Serial Communication

The Serial Open/Serial Close button engages SAMI_Client to communicate with your instrument.
To establish communication, attach the communication cable to your computer and and power
AFT. In Edit → Preferences (PC), or SAMI Client → Preferences (Mac) select the appropriate
serial port. Click the Serial Open button to begin communication with your AFT. The indicator
next to the Serial Port text will specify if your AFT is interfaced with your computer. A red dot
indicates a closed serial port while a green dot indicates an open serial port (Figures 6 and 8).

If the Auto-Open Serial box is checked in the Preferences pop-up page, the Serial Open/Serial Close
button will no longer be visible and the AFT will automatically try to establish communication
when it is powered on.

5.5.2 Power Settings

Port Powered/Re-power: The AFT has an internal battery that will make sure that data
is stored when the instrument is not powered. However, the AFT must be connected to an
outlet in order for you to communicate with it and run it. The communications will time out
after 3 minutes, unless you override this feature by selecting the External Power radio button.
If the port does time out, you can re-open it by simply clicking the Re-power check box. If
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Figure 9: Communication preferences pop-up window

communications has timed-out, you cannot send commands or program the AFT until the
port is re-powered.

If the AFT is running, however, the AFTwill send data out over the serial port after each
measurement or other event, even if the port is timed out (The AFT powers up the port just
long enough to send data).

Save Battery: The Save battery option allows the AFT to go into time-out after three minutes.
This is not necessary with the AFT, since it is not powered with a battery. This function
may also be controlled from the Utility tab.

External power: You can select this option to keep communication open with the SAMI_Client
at all times. If External Power is selected, the message “Port power on until disconnected”
will appear under serial port. This function may also be controlled from the Utility tab.

5.5.3 Deployment Cycle Controls Panel

Download: The Download button will copy data stored on your AFT to a location you select
on your computer. A default file name of SAMI_UnitName_DDMMYY will be suggested in the save
dialog. Data will not be erased from the AFT by using the Download function. If download
fails, try it again.

Erase: The Erase button will clear the memory on the AFT of the data that it previously
collected. To launch your AFT you must erase all data stored on the AFT. If you wish to
save the data from your last data collection you MUST download the information before it is
erased. If you attempt to erase data before it has been downloaded, you will get a warning
message “Data has not been downloaded!” OK will erase all data and settings!

Add Text: The Add Text button allows you to add notes to the instrument’s memory. The
notes will be displayed in the data output files and can be accessed from the toolbar SAMI
→ Read SAMI Text.

Launch: Unless the AFT has been erased, it cannot be launched. Prior to launch, use the
controls in the Settings tab to configure the AFT (see section 5.6). If you have set a launch
time that has passed, you will get the message “Start is less than 10 seconds from now! Would
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you like to start in 10 seconds?”. This may be OK for bench-top testing, but if you require data
aligned to the hour, or a particular stop time, you should program the start time accordingly.

Stop: The Stop button will end the launch of your instrument and sampling will cease. Data
will be saved in the memory of your instrument.

5.5.4 Configuration status Panel

Serial Port Opened: The AFT has established communication with your computer.

Config loaded and AFT started: Indicates that your program has launched and measurement
collection has begun.

(#:) of Pages downloaded This message appears when a measurement sequence has been
stopped and you have downloaded a file.

Erased: The memory has been cleared and you may begin another measurement sequence.

5.5.5 Flags

The Flags section will display messages that indicate status:

This AFT: Name: SN: Hardware: Firmware:

Recording Started: Data is being collected and stored in your instrument’s memory.

Recording Stopped: The measurement sequence has stopped. The data has not yet been
downloaded or erased.

Downloaded: The measurement sequence has been stopped. The data has been downloaded,
but not erased. Erase your data before continuing with another sequence of measurements.

Run Status:

While the program is running, the Run Status will display the date, time, number of data files
collected, and the memory used. The Run Status section will remain blank if the program is
not running, the files have been downloaded, or the data file is erased.

5.5.6 Battery, Temp, Externals Panel

Figure 10: Battery, Temperature, Externals panel

Clicking the Read button updates in-
formation on the battery voltage, and
the temperature in Celcius. The AFT
is not configured to run external de-
vices.
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5.6 Settings Tab

Overview The Settings tab contains the various control panels used to configure the instrument
prior to a deployment. These control panels allow the user to set the start time and run duration,
sampling interval, etc. It is important to note that these settings are not sent to the instrument
until the user launches the unit via the Launch button in the Deployment Cycle Controls (section
5.5.3).

Figure 11: Settings tab.

5.6.1 Start-Stop Panel

In the Start-Stop panel in the upper left hand corner of the Settings tab you will enter your
deployment start time and the run duration. You may enter the exact time you wish to launch
your instrument, accurate to five minutes. Note that you may display your time in GMT or local
time. However, data is stored on the AFT in GMT, regardless of the time format set here. When
you enter the run duration in the specified box, a message appears below which will calculate the
end time and date.

In the event that the start time has passed, you will receive a message informing you the start
time has passed. When you Launch your instrument a message box will ask if you wish to begin
sampling in ten seconds. By selecting OK measurements will begin immediately. Otherwise you
may select a new start time by selecting Cancel.
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5.6.2 SAMI/AFT Panel

The SAMI/AFT panel is where you will enter the sampling interval. In the dropdown menu in the
top center of the box, select SAMI-pH (Vb+). The sample interval must be entered in minutes and
with a time of no less than five minutes (15min or longer is optimal). If you enter a time less than
15 minutes, the Client will give you a warning, which can be ignored. Enter the approximate or
measured salinity of the sample in Salinity Default. This salinity will be used to calculate pKafor
the pH measurement. The grayed-out controls on the right hand side of the control panel are not
user adjustable, but visible for trouble shooting and support.

5.6.3 External Device Panels

External devices are not supported by the AFT.

5.7 Utility Tab

Figure 12: Utility tab.

The Utility tab is generally used for trouble-shooting, to flush the AFT prior to deployment or
storage, and for data processing.
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5.7.1 Serial Port Open-Close, Port Power

These functions can be controlled from the Control tab or from the Utility tab in SAMI Client
version 1 version 2, these controls are only available from the Control tab.. See explanation in
section 5.5.4.

5.7.2 Interactive

The Interactive panel will give you live feed on the data that your instrument is collecting . With
each measurement, a string of information is written to the window. The first line will start with
“Launch.” The next line will have the headers for the following columns of data: sample type, year-
day, initial internal temperature, (434 nm reference, 434 nm signal, 578 nm reference, 578 nm signal)n,
final internal temperature, battery voltage, external temperature. All readings are 12-bit when us-
ing SAMI Client version 1, 12-bit for version 2. n is # Blanks plus # Measurements from the
Settings; default is 27. Data will be written to the screen each time a measurement is taken. This
information is mostly for trouble-shooting. The records are not processed (i.e. pH, etc. is not
calculated). At the top of the display you will notice a button marked Clear which will clear the
display. The Clear button will not erase data from the memory.

Read LEDs: The Read LEDs button allows the user to check the Reference and Signal
intensities of the instrument. This can help alert the user to problems such as a blocked flow
cell path or malfunctioning valve and can otherwise help to ensure the instrument is ready to
deploy. LED signals shoud be greater that 1000 when using SAMI Client version 1, greater
than 6000 for version 2.

Pre-Start: The instrument can be programmed to perform functions while it is waiting to
start. If this has been configured, it will read battery and temperature as programmed in the
Pre-start panel of the Control tab.

Sample: The Sample button will run a measurement according to your programmed spec-
ifications. The measurement will not be saved in your stored data but will display in the
Interactive panel, unless the instrument has been launched.

Device 1, 2, 3:

This will take a reading of the device selected. The data will not be saved in your stored data
but will display in the Interactive panel.

5.7.3 Power Externals

The Power External buttons located beneath the Interactive screen and can power the pump or
valve. External devices are not supported by the AFT.

5.7.4 Cycle Pump

The Cycle Pump function is available to flush your instrument. Flushing is an important function
for the health of your AFT as well as to maintain a clear optical path. To flush the AFT you will
need to attach the small fluid bag that came with the AFT or submerge the inlet tubing in deionized
water, and click on pH Flush. The instrument will need to be flushed after each deployment. Do
not check the Open Valve box, as this will flush the instrument with reagent.

The Open Valve box will initiate the valve during the pumping cycle. When this boxed is checked,
reagent will be pumped through the instrument.
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The # cycles refers to the number of 50µL pumps you wish to flush through the instrument. You
may choose up to 99. Interval (secs) refers to the amount of time between each 50µL pump (1 s or
greater).

5.8 Viewing Data

Data can be viewed in real time or imported from a file after download. On the Control or Utility
tab the Read Real Time button becomes activated when the software detects a new measurement
record (if you have connected to a AFT that is already running) or immediately after the Launch
button is pushed. Data that has been previously downloaded can be imported by selecting the
Open Data File button or selecting Import Data File from the File menu.

5.8.1 Data Overview:

Raw AFT data is stored as records while the AFT is running. These same records are transmitted
over the serial port as well, so the client software will recognize and interpret them in real time.

Raw Record Structure: There are two main types of records recorded by the instrument.
There are data records and information records. Every record leads with an identifying
number (Record Type) and a 4-byte time stamp. Information records note events such as
start, stop, low battery and possible errors if one should occur. Data records follow the
type/time fields with a series of fields composed of the various readings (e.g. temperature,
dark signal) needed for the measurement. In raw format these readings are not especially
informative except in trouble-shooting situations.

Computed fields: Computed fields consist of data derived from the raw records. For example,
the raw thermistor reading is stored as a 12- or 14-bit number. The temperature field is the
temperature calculated from that raw number. Time is stored as a 4-byte number reflecting
total seconds since Jan 1, 1904, while calculated fields allow time to be displayed in a variety
of formats.

5.8.2 Viewing real time data:

The Real Time Data button plots data that is being collected by the instrument in real time. When
you click on the Real Time Data button, a pop-up with a drop down menu titled Column Set will
appear. AFT Client has a number of previously compiled parameter sets that you can choose from
in Column Set Lists. Choose pH_ConstSal. Be sure that the approximate salinity is entered in
Salinity Default on the Settings tab. Select Make View Win to view the data. A new window will
open with data in spreadsheet format. A drop down menu titled Display Type allows you to view
data in spreadsheet or scatter plot format.

Spreadsheet: The Spreadsheet format will allow you to view the data being collected as a list
(Figure 14).

Scatter Plot: Under the Scatter Plot data display select the x-axis and y-axis parameters you
wish to plot (Figure 15).

Creating your own set of parameters to view: If a pre-fabricated set of parameters does not
include the information that you would like to view, you may create and name your customized
Column Set List. By selecting Edit List... from the Column Set drop-down window you will
receive a Set List Editor. You may adapt a previously existing list or create a new one.

Editing a pre-existing list is done by highlighting the list you wish to edit and clicking the
button in the lower right hand corner labeled Edit. A list of the parameters appears in a new
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Figure 13: Real-time data dropdown menu.

Figure 14: Processed data in spreadsheet format.

Figure 15: Processed data in scatter plot format.
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window. The left side window labeled Columns will display all parameters contained in the
Column Set List. Clicking the Add button below the window will make available two drop
down menus on the right side of the window. The Column Type drop-down menu will provide
you with the classifications of parameter we have to choose from. You may be interested in
viewing raw data or processed data. By selecting the type of data you can choose the exact
parameter you wish to plot in the Column Name drop-down menu below. There you may
select from a number of different parameters to populate your Column Set List: sample or
reference signals of a specific wavelength, ratio of signals to reference, temperature, time,
battery voltage, and pH.

To create your own Column Set List, return to the Column Set List editor. Select Add from
the buttons at the bottom of the window. A Column Editor will appear with an untitled
Column Set List. Name your Set List and populate the parameters in the same fashion as
described above.

5.9 Data Processing

5.9.1 Processing text files

Once data has been downloaded, you can view raw and processed data with AFT Client software.
Go to File menu and select Open Data File. A window will appear that asks you to select what
data you want to extract from the file. In the drop down menu, select pH_ConstSal for constant
salinity (the approximate salinity of your sample must be entered in the Salinity Default box on
the Settings tab). If you logged CTD data independently and want to use the measured salinity,
you will need to process the data using QC_PH, as described in section 6.

Next, click on the Parse File button. Data can be viewed as a spreadsheet or scatter plot and
exported as a text file. Although you can only view the first 500 rows of data, you can process
and export the entire data file. Note that this is preliminary data. QC_PH, included on your disc,
filters and processes the data more thoroughly. This is described in section 6.

5.9.2 Processing hex files from a custom interface

The AFT data can be collected from the user’s system via RS-232. Data collected this way will be in
hex format. A hex file can be imported and processed in SAMI_Client. From the File menu select
Import hex File. In the dropdown menu choose pH_ConstSal. In the upper right hand corner of
the Import menu, select Choose Config File and choose a configuration file. A configuration file is
saved when you launch the AFT. If you did not save the configuration file when you started the
instrument, a generic configuration file can be saved at any time. Once the hex data is imported,
the functions of the program are the same as when reading AFT txt files.
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6 Processing Data With QC_PH

QC_PH is a standalone Matlab program that reads data files from the AFT Client. This program
does a better job of filtering out outlying blanks and sample points that resulted from air bubbles,
and flags those points as well as points where a mechanical error such as a failed valve or pump
might have occurred. pH values calculated from SAMI_Client and QC_PH will differ slightly, due
to blank filtering and smoothing by QC_PH. QC_PH provides more reliable pH values.

6.1 Installing Matlab Runtime and QC_PH Application

On the AFT disk, open the folder QC_PH, copy the appropriate folder for Macintosh or PC to your
computer and open the folder, then double-click on the application. For PC the application will
be a *.exe file, for Macintosh this will be a *.dmg file. This will guide you through installation of
Matlab runtime as well as QC_PH. It will require web access and will take a bit of time, depending
on the speed of the internet connection. Future updates to QC_PH will install quickly. If you need
a complete installer (no internet access), please contact technical support. The default folder for the
application is Programs\Sunburst Sensors\. You can move an alias or shortcut of the application
to a more convenient location.

6.2 Running QC_PH

Figure 16: PH Options.

To run QC_PH, double click on the
icon. You will be prompted to choose
the AFT data file. After reading the
file, the app will ask you to choose
Constant Salinity, Measured Salinity,
or Tris Validation. Choose Constant
Salinity if salinity was not measured,
but you know the approximate value.
Enter the salinity in the Salinity box.
Choose Measured Salinity if you have
a data file from a CTD that was de-
ployed with the AFT. You will next
be prompted to choose the CTD file.
This file must be a tab delimited text
file in the format: mm/dd/yy Tab
hh : mm : ss Tab salinity. The times
in the CTD file must cover all times
in the SAMI file. If they do not, you

can copy a line of data to the top or bottom of the file, using an appropriate time. Choose Tris
Validation if you are running a Tris buffer with known pH for validation of instrument accuracy.

Figure 17: Range of points to plot.

QC_PH will calculate pH and shows
plots of signals, absorbances, blanks,
point pH, temperature, and final pH.
These plots can be useful in trou-
bleshooting a AFT. You can set the
range of samples to view by chang-
ing the Start Sample and End Sam-
ple and selecting Re-Plot on Figure
1. Select Save Figs to save the fig-
ures and Close All to close the Figure
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windows. Figures and a text file of
the output data will be saved in a folder named “Filename_Results.”

6.3 Interpreting QC_PH Data and Figures

QC_PH will plot several figures. The figures that are often used to determine data quality and
instrument performance are described here.

The Intensity/Absorbance plot indicates instrument performance (Figure 18). The top plot is
reference signals, which should remain constant, but might degrade gradually over the course of a
deployment. The middle plot is signals through the optical cell. These signals start high at the
beginning of a sample (blank), drop as indicator moves through the cell, and gradually increase
back to the blank values. Smooth curves indicate the AFT is working well, whereas flat lines or
many spikes in signals indicates malfunction. The signals are plotted “Raw” and after outlying
points are filtered out. Each line is for one sample measurement.

The Blank plot plots the signals of the blanks measured at the beginning of each sample (Figure
18). These signals will degrade gradually over the course of a deployment, but should not have
large spikes, and should remain above 1000 for Sami Client version 1, 4000 for version 2). Each
point is the blank for one pH measurement.

The point pH plot (not shown) shows the pH measured at each point during the sample measure-
ment. The final pH is an extrapolation of point pH versus total indicator concentration to the pH
at zero indicator. Each line is one pH measurement.

The Flags plot indicates problems that might have occurred during a sample measurement. If flags
are all 0, there are no obvious errors. Any flags on 1 indicate that a blank value was not consistent
from other blanks, and the pH measured could be erroneous. Flags on 2 indicate that the signal
was saturated at some point during the measurement, and the pH measured could be erroneous.
Flags on 3 indicate that the pump was not working, and the pH measurement will read NaN (not
a number). Flags on 4 indicate that at least one point during the measurement was an outlier.
The software will throw out the outlier, so this flag does not necessarily indicate an erroneous pH
measurement.

Figure 18: Signal intensity plots (left) are plotted as 28 points for each measurement (top: ref-
erence signals, middle: signals through cell, bottom: absorbances through cell); ratios of blank
signal/reference signal (right) are plotted as one point per measurement (434 nm signal shown in
blue; 578 nm signal shown in red).
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The Final pH plot shows the temperature and pH measured throughout the deployment (Figure
19). Each point in one pH measurement. pH noise from one measurement to another should be
less than 0.002 pH and temperature noise should be less than 0.05 ◦C. As blank signals degrade, pH
precision might also degrade.

Figure 19: Final pH (blue) and Temperature (orange), plotted as one point per measurement.

The data output file will contain columns for date, pH measured, the potential error of the measured
pH (estimated from the fit of the plot of point pH versus total indicator concentration), temperature
measured, and flags. In the flags column 0000 indicates no flags, 0001 (1 line on plot) indicates a
blank flag, 0010 (2 line on plot) indicates a saturated signal, 0100 (3 line on plot) indicates pump
failure, 1000 (4 line on plot) indicates an outlier. If the file is opened in Excel the leading zeros will
be absent. The flags are described in more detail above.
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7 Care and Maintenance

7.1 General Cleaning

After your AFT has been in use, even for short periods of time, we recommend flushing it with
deionized water to solvate any crystals of indicator or salt that may have formed. WARNING:
Failure to flush your AFT may result in your instrument’s inability to function properly!

7.2 Clearing air-locked or clogged AFT-pH

An air lock can occur when the instrument runs samples out of the water, allowing air to be
pumped into the tubing before it is deployed. If you are testing the AFT on a bench top, be sure
to attach a bag of deionized water to the inlet or place the inlet into a beaker of deionized water.
When deployed in water with high amounts of sediments, materials can also cause a clog in the
instrument. An air lock or a clog can be cleared with the steps below.

1. Remove the screws from the wet chamber and take the lid off the AFT (Figure 20).

Figure 20: AFT with wet chamber lid open.

2. Fill the syringe with deionized water and connect to the blue fitting on the intake tubing
inside the wet chamber of the AFT (Figure 21).

3. Connect the AFT to power and a computer with the Client software installed. Open SAMI_Client.
In the Utility tab under the Cycle Pump panel, set the # cycles to 10. Apply a constant
pressure to the syringe and click Run. Open Valve should NOT be checked.

The deionized water should move through the system and come out of the cell outlet tube
(long green tubing protruding from the PEEK cell). This step may be repeated a couple
of times. If the water does not move through the instrument, contact Sunburst Sensors for
additional technical support.
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Figure 21: Clearing an air-locked AFT

4. Once fluid begins to move through the system, insert the intake tubing (the tube with the
blue fitting where the syringe was attached) into a beaker with a few hundred milliliters of
deionized water, or connect the blank bag to the inlet.

5. Next flush the AFT using deionized water from the beaker or the bag. On the Utility tab
under the Cycle Pump panel set the # of cycles to 99 and click on Run. Make sure the intake
tube is in the deionized water before pressing the Run button. Open Valve should NOT be
checked.

The deionized water should move through the system normally. If the water is not mov-
ing through the instrument, contact Sunburst Sensors for technical support at techsup-
port@sunburstsensors.com.
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8 Troubleshooting

These are a few common questions that we receive at Sunburst Sensors. If you do not see your
question here, please contact us at techsupport@sunburstsensors.com.

What do I do if I cannot communicate with the instrument? You will not be able to communi-
cate with your instrument if the correct serial port has not been selected. In SAMI_Client select
Edit → Preferences and try choosing another serial port from the menu. Many times it may take
some time for the computer to fully populate the list. You may need to wait until another serial
port appears in the drop-down menu. The COM port on the PC will typically be the last one
in the list. On a Mac the serial port will be named USB-serial XXXXXXXX where “X” represents
alpha-numeric characters.

On Windows operating systems (7, 10) it is sometimes helpful to go to the Device Manager (Control
Panels, System andMaintenance, System) and look for the Ports to verify your USB-Serial converter
is working. There should be at least one USB Serial Port under Ports (COM & LPT). Double click
to open and verify that it is the FTDI converter and not some other device. Use this port number
in the SAMI Client Preferences.

If you do not see a USB serial port, it is likely that you will need to install the driver. Try unplugging
and re-plugging the cable to the PC. This should prompt an install dialog. If this does not work,
you can manually install the driver from the install CD or from http://ftdichip.com/Drivers/
VCP.htm

On some PCs switching to another USB port will solve the problem. Also, it is occasionally useful
to restart the AFT Client software and/or the PC itself.

What happens if the signals drop? This is very likely due to an obstruction in the path of the
optical cell. Commonly, it is air bubbles which can be flushed out by continually pumping. If you
use the Cycle Pump function on the Utility tab of SAMI_Client to pump deionized water (after
filling the wet chamber with DI or tap water) through the instrument, the problem will often be
resolved.

What should the signal intensities be? If you are using SAMI_Client version 2.01 or higher, sig-
nal intensities can range from 0 to 16383. If any signal intensity is at or near 16000, the channel
may be saturated with light, giving erroneous results. Reference and signal intensities should be
greater than ∼ 6000 for a blank (DI, seawater, etc.). Lower intensities will result in higher noise
in absorbance and thus pH measurements. However, if during a measurement signal intensities
are low but reference intensities are not, the flow cell needs to be flushed with DI or tap water.
Dark signals will normally range from ∼ 200–400. Higher or erratic dark signals could indicate an
electronic problem with your AFT. Contact Sunburst if any abnormal signals cannot be rectified.

If you are using SAMI_Client version 1.35 or lower, signal intensities can range from 0 to 4095. If
any signal intensity is at or near 4000, the channel may be saturated with light, giving erroneous
results. Reference and signal intensities should be greater than ∼ 1000 for a blank (DI, seawater,
etc.). Lower intensities will result in higher noise in absorbance and thus pH measurements. How-
ever, if during a measurement signal intensities are low but reference intensities are not, the flow cell
needs to be flushed with DI or tap water. Dark signals will normally range from ∼ 50–200. Higher
or erratic dark signals could indicate an electronic problem with your AFT. Contact Sunburst if
any abnormal signals cannot be rectified.

How do I flush my AFT? There is a function on the Utility tab of the SAMI_Client labeled
Cycle Pump. Under cycle pump you may flush your AFT without disrupting the programmed
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measurement routine. In addition, the user may use the de-clogging kit that is included with all
new pH instruments. See section 7 for instructions on using the de-clogging kit.

My Spreadsheet Maker did not populate the Column Set List! It is very likely that the file in-
cluded on your instrument disc was not copied over to your computer. Please double check that
every file on the disc has been successfully transferred including a file labeled ColumnSettings.txt.

QC_PH will not read my CTD file. Make sure that your CTD file is formatted correctly (see
Section 6) and that the times cover all times in the SAMI file. Extra lines of data can be pasted at
the top and bottom of the file to include missing times, if necessary.

What if I cannot rectify my problem? Contact Sunburst Sensors, our information is found on the
front of this manual. We will work with you to find the fastest and most economical solution to your
problem. Never hesitate to give us a call or send us an e-mail at techsupport@sunburstsensors.com.
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9 Low level operation of the AFT

The AFT has a very robust, user-friendly client that is recommended for programming, download-
ing, and updating. That being said, there are some users who wish to have a lower level control of
the instrument. This document attempts to explain the low level operation of the AFT.

RS-232 Serial Communication

The AFT uses RS-232 to communicate with 8-none-1 settings. RTS must be held high to turn on
the RS-232. When RTS is asserted the AFT will begin to send status strings every second. For
interactive use, these status strings should be turned off using the F5A command (see Low Level
Commands below). Once this command is issued, however, the client software will not recognize
the AFT as being connected. It can be turned back on by F01 if you need to use the client.

Once communications have been established the AFT needs to be stopped (if it is running), down-
loaded (if there is data), and erased.

The command sequence for this is:

Q5A - stop running and close memory
D## - send ## pages of memory over serial port
E5A - erase memory, including RAM variables

At this point the AFT must be configured before it can be used again, setting the time, sample
interval, etc. Configuration is discussed next. While the AFT does not have a strict polling mode,
it can be configured to start long in the future and sent commands to do measurements on a set
interval. To get a measurement once the unit is configured, just send R. (All commands are CR
terminated as discussed below.)

Configuring the AFT

The configuration string sets the various parameters required by the AFT to operate. It sets the
time and date, the start time and end time. It tells the AFT which drivers to use for the AFT itself
(e.g. is it a pH unit or CO2 unit?) and what drivers to use for any devices that are connected to
the AFT. The configuration string also contains all the parameters required by the various drivers,
including timings of pumps, valves, etcetera.

The configuration string is 116 bytes (232 hex characters) in length, which is padded to 128 bytes
(256 hex characters), followed by 128 bytes (256 hex characters) of user text and terminated with a
null character. Each byte is represented by a two character hex string. The beginning of the string
specifies the time parameters and mode, followed by sampling intervals, driver info and pointers to
parameters.

The configuration string is sent or retrieved to/from the AFT by client software using L command
which is described in section 9.

+++++++Overview of Configuration String for Firmware 50+++++++++
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Description Units bytes position in string
Launch time (GMT) secs from 1/1/1904 4 0
Start time from launch secs from launch 4 8
Stop time from start secs from start 4 16
Mode switch bits (see below) 1 24

For AFT, Dev1, Dev2, Dev3, Prestart (5 per row)
Interval secs 3 26, 36, 46, 56, 66
Driver n/a 1 32, 42, 52, 62, 72
PointerToParams offset from pos 78 1 34, 44, 54, 64, 74

Global configuration switches 1 76

Bit 0 Run main serial port at 57600 or 9600
Bit 1 Send ˆ(record type) before a driver starts
Bit 2 Send live records over serial
Bit 3..6 Not assigned, set to zero
Bit 7 Extend Global config.

For AFT, Dev1, Dev2, Dev3, Prestart (pointed to by above)

Parameter bytes various max of 15 78 for AFT, others vary

Max config string length = 13 + (5x5) + 1 + (5x15) = 114 bytes (228 hex chars, padded to 256
chars)

Mode bits

Bit 0 PMI sampling schedule enabled
Bit 1 AFT sampling schedule enabled
Bit 2 Slot 1 follows AFT sample
Bit 3 Slot 1 independent schedule
Bit 4 Slot 2 follows AFT sample
Bit 5 Slot 2 independent schedule
Bit 6 Slot 3 follows AFT sample
Bit 7 Slot 3 independent schedule

++++++++++++++++++++++++++++++++++++++++++++++++++++++

Example of a Configuration String

SAMI-pH programmed on Oct. 6, 2011

AFT uses driver 10,11 (pH-average) on 30 min intervals

All devices follow AFT

Device 1 - Serial +Power
Device 2 - Generic 0–5V +Power
Device 3 - Power
Prestart - 4 hour intervals for DI pump
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:ConfigHex (232 characters)

CAB39E84 000000F4 01E13380 57 000708 0A01 00258 030A 000258 0017 000258 011A 003840 001
C 07 0001230420010808100410081700100101202564000433383335000200010200000000000000000000000
000000000000000000000000000000000000000000000000000000000000000000000000000000000

General timing and mode

CAB39E84 - Time of programming (GMT) - Oct 6, 2011 18:05:56 (total seconds from 1/1/1904)
000000F4 - Time until start - 244 sec
01E13380 - Time from start until stop - 365 days (315360000 sec)
57 - Mode bits - (01010111 - Bits 6,4,2 = all devices follow AFT sample, bit 0= prestart schedule on,
bit 1 = AFT schedule on)

000708 - AFT interval (1800 sec - 30 min)
04 - AFT Driver (CO2 Ave+)
01 - Pointer to params (AFT always 01)

00258 - Device 1 interval (10 minutes - overridden by mode bits above)
03 - Device Driver
0A - Pointer to params (position relative to byte 1 of AFT driver in bytes)

00258 - Device 2 interval (10 minutes - overridden by mode bits above)
00 - Device Driver
17 - Pointer to params (position relative to byte 1 of AFT driver in bytes)

000258 - Device 3 interval (10 minutes - overridden by mode bits above)
01 - Device Driver
1A - Pointer to params (position relative to byte 1 of AFT driver in bytes)

003840 - Prestart interval (14400 sec - 4 hours)
00 - Driver
1C - Pointer (pre-start has no params)
07 - Global parameter switch - send live records, with record type early at 57.6K

SAMI-pH Driver 10/11 Parameters explained

In the example above the SAMI-pH is using driver 10/11, which is default.

0001230420010808100410081700 - driver 10 parameters (SAMI-pH Vb+ driver) see figure 22

10010120256400043338333500 - parameters for serial + power driver

020001 - 02 Duration 00 Power select 01 # samples to average

0200 - 02 Duration 00 Power select

Padding
000000000000000000000000000000000000000000000000000000000
0000000000000000000000000000000000000000000
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Parameter dec hex
Cycles Between Stds 0 00
# Samples Averaged 1 01
# Flushes 35 23
Pump On-Flush(1/16s) 4 04
Pump Off-Flush(1/16s) 32 20
# Reagent pumps 1 01
Valve delay(1/16s) 8 08
Pump on-ind(1/16s) 8 08
P/V off-ind(1/16s) 16 10
# Blanks 4 04
Pump Meas T(1/16s) 16 10
Meas to pump on(1/16s) 8 08
# Measurements 23 17
Salinity Delay(1/16s) 0 00

Figure 22: SAMI-pH settings in decimal and hexidecimal format.

Command Format

• Command format: one letter followed by a number of arguments as hex numbers and ending
with carriage return (CR).

• Args may be separated by Space, Tab, comma, ’/’ or ’:’ the first separator may be omitted.
For example "T 03/05/29 5 12:30:06" is equivalent to "T3 5 29,5,12 30 06"

• 123 is equivalent to 000123 if a long word is expected 0123 if a word or 23 if a byte.

• If more bytes are entered than the command uses the left most (first entered) bytes are
ignored. For example, a command that takes a byte will read 1A2B as 2B.

• Arguments are represented as follows:

(B) One byte (S) 12 bits (W) 2 bytes (L) 3 bytes (E) 4 bytes (X) don’t care, () none,
(N) nibble

{} indicates return expected using above while {R} means returns record

(5A) sending 5A enables a variant of the commands normal function

• Arguments in [ ] are optional. Typically these optional arguments are present for a “write” to
the AFT and omitted if the user wants to “read” from the AFT.

• No backspace or delete support for cmds sent - type non-hex arg with CR to abort.

• Results (reads) are returned as space separated hex and terminated with CR.

• Commands that are illegal or malformed return ?, error code in hex followed by return.

• Any input returns ! if a command or process is running.

• Echo is off by default. Echo off suppresses prompts and error text. Use I command to enable
echo.
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Command List

C (){R} Run Blank cycle on SAMI-CO2

() - no argument required
{R} - returns a data record
A valid configuration is required. If AFT erased then error returned.
Returns (and if running writes) a data record.

D (W,[B],[W]) {memory stream} Dump Memory

(W - arg1) is number of pages beginning from page 0.
[B - arg2 ] - optional format switch 0 for binary, 1 for hex (default is binary)
[W - arg3 ] - optional start page
B - bit 0=1 send as hex return after page, bit 0=0 send as binary
Begins streaming memory with first data record.

E ([B]){W} Erase

() - no argument erases AFT memory
(5A) - for safety erase all of memory and clear ram vars.
{W} - returns the first unerased page or 8000 if all are erased
Erase shuts down all activity including time keeping but allows serial commands.
Stops real time clock

F (B)() Status ticks on/off & special cmd mode

(5A) - turns ticks off -turn off 1/sec status from AFT Enable Debug commands
(55) - turns on optional commands (see section below)
(any other byte) - turns ticks on and disables optional commands

G ([B])() Open flash and start recording

Starts real time clock if it is not running Clears n_drec number of records, n_erec
number of error records. n-bytes Number of bytes stored - Is set to the start of the page
after the last un-erased page. Restarting without erase is supported.

H (N){S} Read one adc channel

(N) - Channel 0..7 or
{S} - returns in Hex ADC count Voltage = (S/4096)*5.00V
0 - Photo Reference, gated in firmware so not useful
1 - Photo Signal, gated in firmware so not useful
2 - Battery if 12V is enabled else 0 V= count/4096*5V*3 Volts
3 - Thermistor
4 - 3rd Party input J6 pin8 - 5V full scale
5 - 3rd Party input J6 pin8 - 5V full scale
6 - 3rd Party input J6 pin8 - 5V full scale
7 - 3rd Party input J6 pin8 - Photo diode amplified current input

Special

If arg ≥ 80 turn on 12V and read Batt, therm, 5V in 1, 5V in 2, 5V in 3, photodiode
restore 12V
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Returns {S S S S S S}

I ([B]){B} Immediate read status sw & bus

arg switches
Bit 0 Pump on
Bit 1 Valve on
Bit 2 12V on
Bit 3 Reserved - was Battery sense enable
Bit 4 debug LED off
Bit 5 echo off
Bit 6 Reserved
Bit 7 Reserved
Return Switches {B} as in arg

J (B) invokes loader returns nothing, used to load firmware after erase

(5A) - branch to loader
(5C) - Erase Board Type and SN 128 Bytes in microcontroller flash

L ([5A]){ConfigString} Load or Read Config + UserText

-- Read or load a string. Consisting of Configuration string (+ fill to 256 bytes) +
UserText
() No argument gets configuration string from board.
(5A) - start 4 byte timer at zero and wait for CR from board After receiving carriage
return, send load data as packed hex with no separator.
First non-hex non-return character causes abort of load.
Either a null between byte 256 and 512 or 512 bytes is a valid
termination. Any non hex is an error.
Returns 2-byte checksum read from flash after write.
Successful load starts real time clock. Erase or reset stops clock

M ([B]){S,S,S,S,S,S} Measure LEDs w/o pumping

Read the ADC values no pump cycle
Arg default = FF (read all)
Bits enable sending of data below bit 2..7 - blue ref...dark signal
Returns {S} in same order as below
bit2 - Dark ref
bit3 - Dark signal
bit4 - LED1 ref
bit5 - LED1 signal
bit6 - LED2 ref
bit7 - LED2 signal

N ( [B] B W W)

Compare or write a byte value to a range of memory W as page count
Verify N(byte value, word Start_page, word count_pages) Return (0 if true, first failed
page if false)
Write N($5A, byte value, word Start_page, word count_pages)
Progress reporting
Returns hight byte of page +1 for each page started then XX last page address where
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XX=00 for good FF for fail
(Should fix this, should be page started then 2 byte end address and 00 or FF)

O ([B]) {B} Read or write port A - set bits enable power out functions

() - no arg is ‘read’ with {B} returned as described below
(B) - arg writes to port A to turn on/off power out as below

Bit0 - 12V
Bit1 - Valve - J4 pin6
Bit2 - Pump - J4 pin7
Bit3 - 3rd party power J5 pin 6
Bit4 - 3rd party power J5 pin 5
Bit5 - 3rd party power J5 pin 4
Bit6 - Select 12V for 3rd party power
Bit7 - Select Battery for 3rd party power
Note that if both bit 6 and 7 are set, bit 7 is cleared - 12V is selected

P ([B],[B]) Pump and valve powering

() - no argument pump and valve off
(B1) - one arg set pump and valve on or off
(B1,B2) - 2 args set on or off and restore after arg2 1/8 seconds
B1 - bit 0 turns pump on, bit 1 turns valve on
B2 - time to hold state of B1 before returning to original state (1/8’s sec)
Turns on 12V supply if required and restores to original state
Return Null just carriage return after time out - single threaded

Q (5A)() Close flash and stop recording.

R ([B])(R) Run sample cycle on device

Arg Slot Default device is AFT - 0 slot1..3, PMI is 4
Arg set bit 3 returns test error/info rec
Arg bit 2 selects error/info record
A valid configuration is required. If erased then error.
Returns (and if running writes) a data record

S ([B]){: E,W,L,L,L,W,W} Ask for status from AFT (note this is auto sent when RTS is high)

(B) If arg=0 (default) returns : followed by :
{E} time in seconds since L command - Cleared by Erase
{W} statusflags - Cleared by Erase, defined here:

bit 0 Clock started
bit 1 Recording started
bit 2 Recording ended on time
bit 3 Recording ended memory full
bit 4 Recording ended due to error, failure, or user stopped
bit 5 Data downloded
bit 6 Flash Open
bit 7 *Low or no battery before start 256*t_pmi seconds - fatal
bit 8 Battery low on measure cycle - fatal
bit 9 Battery low on blank cycle - fatal
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bit 10 *Battery low on external device cycle - fatal
bit 11 *External device 1 fault - fatal for device shut it down
bit 12 *External device 2 fault - fatal for device shut it down
bit 13 *External device 3 fault - fatal for device shut it down
bit 14 Erased
bit 15 Power on flags not valid

( * Not yet implemented )

{L} - n_rec (3) number of data records - Cleared by Erase
{L} - n_erec (3) number of error records - Cleared by Erase
{L} - n_bytes (3) Number of bytes stored including config and user text as full pages -
Cleared by Erase
If arg=1 returns Name(16) SN(4) FirmwareVer(4) AFT board version(2) AFT board
Config(2) Cal(24) Cksum(1)
If arg=2 returns 128 bit microcontroller flash Name(16) SN(4) calibration TBD Check-
sum(1)

Commands turned on by F55 command

@ ([X],[X],[X]...)(T) Test the command parser

Debug tool only works if echo is on.
Reports in text the number and value of args.

A (X)(T) List all commands

Debug tool only works if echo is on.
Lists all the commands.

B ( )(S) Battery Voltage

S the battery voltage 12V must be enabled Vbat = Arg ∗ 5 ∗ 3/4096

T () (s) Thermistor Voltage

V = 4096 ∗ ThermistorRes/(ThermistorRes+ 17400)

Debug tools hidden - enabled by F5A

Z (W)( ) Set breakpoint

ˆC Break to debugger

ˆT Show current program address and reg.

Extra debug commands for now

K Send error CF with 2 extra bytes &h0201

V No arg send ’Hello World’ out secondary port and echo for 10 sec then return ’Done’

V Any arg send ’Hello World’ out serial port and return 0 if all
characters echo - for tester
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W Return status word, MFG code, etc.

X Sleep for ever but wake every 8 sec and send time - reset to exit

Y Show time, internal flags, wake counter

Notes

While DTR is present on the serial port command mode is maintained and 5V power is on. 12V
power is off by default but can be turned on with I or O command.

12V power will cycle on and off as needed to run pump or valve.

*** Command Error Codes ***

00 Wrong Number of Arguments
01 Command Not Implemented
02 Invalid Arguments
03 Command Buffer Overflow
04 Invalid Command Enter A return for a list of commands
05 Error in config data
06 > 2000 pages
07 Invalid Configuration
08 Bad Key
09 Flash is Open
0A Flash is Not Open
0B Too Many Arguments
0C Too Few Arguments
0D Memory Full
0E Not Valid With Echo Off
0F Unimplemented Extenstion Index in Configuration
10 Flash Data not erased
11 Invalid Arguments
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Error conditions

No battery - If main battery without load at wake from sleep is below Vmin.

AFT counts no battery event and schedules next wake for measurement.

Note that AFT does not attempt to write Flash memory on backup battery.

If 2 byte no battery count overflows AFT shuts down completely.

If AFT awakes to find battery restored it writes an error record with counts and time and resumes
normal operation.

Battery fail - if AFT tries to power up analog, pump, valve, or external device and battery falls
below Vmin:

write an error record

close Flash page

shutdown completely until handshake from host.
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Warranty

Sunburst Sensors, LLC warrants to the original purchaser that instruments manufactured by Sun-
burst Sensors shall be free from defects in materials and workmanship for the life of the product.
Under this warranty, the instrument will be repaired or replaced as deemed appropriate by Sunburst
Sensors without charge for parts or labor when the instrument is shipped prepaid to our location.
This warranty does not apply to any instrument which has not been installed or used in accordance
with proper operation and installation specifications. Sunburst reserves the right to void any war-
ranty, written or implied, if upon Sunburst’s examination of the instrument reveals failure was due
solely, or in part, to accident, misuse, neglect, abuse, alteration, improper installation, unauthorized
repair or improper testing by the buyer. Sunburst shall not be liable under any circumstances for
indirect, special, consequential, or incidental damages in connection with, or arising out of, the
sale, performance, or use of the instrument covered by this warranty. When a Product is returned
to Sunburst Sensors for refurbishment/recalibration this service is considered normal preventative
maintenance. Recalibration of your instrument shall not be treated as a warranty service unless
recalibration of your instrument is required as the result of repairs to the instrument pursuant
to this Warranty. Your instrument may only be repaired and refurbished by a certified, trained
specialist from Sunburst Sensors, LLC. Breach of this requirement without prior consultation from
Sunburst Sensors may result in the voiding of your Warranty.

If you would like more information on your AFT for self-repair or refurbishment please contact
Sunburst Sensors. After notification is given that the interior of the instrument will be accessed,
Sunburst Sensors is no longer responsible for defects incurred under the by the user.
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Material Safety Data Sheet

1. IDENTIFICATION OF THE
SUBSTANCE/PREPARATION AND OF THE
COMPANY/UNDERTAKING
Product name: m-Cresol Purple sodium salt
Product Number: 211761
Company: Sigma-Aldrich
3050 Spruce Street
SAINT LOUIS, MO 63103
USA
Telephone: +18003255832
Fax: +18003255052
Emergency Phone: (314) 776-6555

2. COMPOSITION/INFORMATION ON
INGREDIENTS
Synonyms: m-Cresolsulfonphthaleinsodium
salt
Formula: C21H17NaO5S
Molecular Weight: 404.41 g/mol
CAS-No. EC-No. Index-No. Classification
Concentration
m-Cresol Purple sodium salt
62625-31-4 263-656-9 - - -

3. HAZARDS IDENTIFICATION
Not a hazardous substance or preparation
according to EC-directives 67/548/EEC or
1999/45/EC.

4. FIRST AID MEASURES
If inhaled
If breathed in, move person into fresh air. If
not breathing give artificial respiration.
In case of skin contact
Wash off with soap and plenty of water.
In case of eye contact
Flush eyes with water as a precaution.
If swallowed
Never give anything by mouth to an
unconscious person. Rinse mouth with
water.

5. FIRE-FIGHTING MEASURES
Suitable extinguishing media
Use water spray, alcohol-resistant foam, dry
chemical or carbon dioxide.
Special protective equipment for
fire-fighters
Wear self contained breathing apparatus for
fire fighting if necessary.
Aldrich - 211761
http://www.sigma-aldrich.com Page 2 of
4.

6. ACCIDENTAL RELEASE MEASURES
Personal precautions
Avoid dust formation.
Environmental precautions
Do not let product enter drains.
Methods for cleaning up
Sweep up and shovel. Keep in suitable,
closed containers for disposal.

7. HANDLING AND STORAGE
Handling
Provide appropriate exhaust ventilation at
places where dust is formed. Normal
measures for preventive fire protection.
Storage
Store in cool place. Keep container tightly
closed in a dry and well-ventilated place.

8. EXPOSURE CONTROLS/PERSONAL
PROTECTION
Personal protective equipment
Respiratory protection
Respiratory protection is not required. Where
protection from nuisance levels of dusts are
desired, use type N95 (US) or type P1 (EN
143) dust masks. Use respirators and
components tested and approved under
appropriate government standards such as
NIOSH (US) or CEN (EU).
Hand protection
For prolonged or repeated contact use
protective gloves.
Eye protection
Safety glasses.
Hygiene measures
General industrial hygiene practice.

9. PHYSICAL AND CHEMICAL
PROPERTIES
Appearance
Form powder.
Color
Dark red
Safety data
pH: No data available.
Melting point: No data available.
Boiling point: No data available.
Flash point: No data available.
Ignition temperature: No data available.
Lower explosion limit: No data available.
Upper explosion limit: No data available.
Water solubility: No data available.
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10. STABILITY AND REACTIVITY
Aldrich - 211761
http://www.sigma-aldrich.com Page 3 of
4.
Storage stability
Stable under recommended storage
conditions.
Materials to avoid
Strong oxidizing agents.
Hazardous decomposition products
Hazardous decomposition products formed
under fire conditions. Carbon oxides, sulfur
oxides

11. TOXICOLOGICAL INFORMATION
Acute toxicity
No data available.
Irritation and corrosion
No data available.
Sensitization
No data available.
Chronic exposure
IARC: No component of this product present
at levels greater than or equal to 0.1% is
identified as probable, possible or confirmed
human carcinogen by IARC.
Potential Health Effects
Inhalation: May be harmful if inhaled. May
cause respiratory tract irritation.
Skin: May be harmful if absorbed through
skin. May cause skin irritation. Eyes: May
cause eye irritation.
Ingestion: May be harmful if swallowed.

12. ECOLOGICAL INFORMATION
Elimination information (persistence and
degradability)
No data available.
Ecotoxicity effects
No data available.
Further information on ecology
No data available.

13. DISPOSAL CONSIDERATIONS
Product
Observe all federal, state and local
environmental regulations.
Contaminated packaging
Dispose of as unused product.

TRANSPORT INFORMATION
ADR/RID
Not dangerous goods.
IMDG
Not dangerous goods.
Aldrich - 211761

http://www.sigma-aldrich.com Page 4 of
4.
IATA
Not dangerous goods.

REGULATORY INFORMATION
Labeling according to EC Directives
Further information: The product does not
need to be labeled in accordance with EC
directives or respective national law.
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